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Working with eXtyles

Working with eXtyles describes the eXtyles feature set and 
offers tips to enhance the user’s experience. Unlike the lengthier eXtyles User 
Documentation distributed to all customers, this guide is a general overview, and 
some details may vary depending on your organization’s specific configuration. 
Inera will occasionally update this document, and a current version will always be 
available on our website at http://www.inera.com/support/documentation. 

Solutions to common technical support questions can also be found on our site at 
http://www.inera.com/support/technical-support.
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Document Check

When you first open a document in Word for use with eXtyles, you should give the document a quick visual review. 
Look to see if the document has any formatting that is particularly unusual (especially large or small fonts, odd 
typefaces, or garbage characters). Such formatting problems may indicate a document that was poorly imported 
from another Word processing program or will cause other problems as you work with it.

You should also review any tabular material that appears in the document. Authors have been known to use a 
variety of creative methods to construct tables in Microsoft Word. eXtyles is optimized for tables that have been 
built using the Word table editor. Before activating a document with eXtyles, you should convert all tables built in 
other ways (tab-delimited, Excel, etc.) into Microsoft Word tables. If tables are not converted to Word table format 
before eXtyles activation, you may lose the layout of the table, or some eXtyles functions may not work correctly.

Document Audit (Font Audit)

The first item on the eXtyles menu is Document Audit. The Font Audit option is found on this menu. Font Audit 
finds all fonts that have been used in a document and presents a list to the user. Font Audit must be run on each 
document before eXtyles activation — if you run it after activation, the results may not be accurate.

eXtyles fully supports most fonts. The most important use of Font Audit is to detect when an author may have 
used a special character font that is not supported by eXtyles. This should be a rare occurrence, but if an unfamiliar 
or oddly named font appears, check our up-to-date list at http://www.inera.com/support/documentation, 
which includes both supported fonts and all unsupported fonts of which Inera is aware. If the font is listed as 
unsupported, carefully review the file after eXtyles activation using Compare to Baseline — you may have to 
reinsert some special characters.

Activation and Normalization

In this step, eXtyles activates your document (allows it to be processed) and normalizes it (prepares it for 
processing). The user also provides eXtyles with information about the file that is being prepared for processing.

A few things happen during activation of which the user should be aware. First, if Word’s Track Changes feature is 
turned on, eXtyles accepts all changes and turns off Track Changes (it can be turned on again when you begin to 
edit the document). Second, if the author has used Word footnotes and/or endnotes, these are converted to plain 
text and moved to the end of the document (footnote numbers or symbols are, however, preserved).

Setting Document Information

Every organization that uses eXtyles has a customized Document Information dialog. In this dialog, the user 
identifies the publisher, publication, article type, etc., of the current file. Some of the fields in the dialog are starred 
(*) — these must be filled in before the user can proceed with eXtyles processing. For instance, eXtyles needs to 
know in what publication the document will appear in order to apply the correct editorial style. Other fields may 
not be required — for example, issue number, since processing of manuscripts often occurs before a paper has been 
assigned to an issue.
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During activation, you have the option of selecting the “Add Document Information to Header” checkbox. If you 
select this, the metadata (the information about the paper that you’ve entered into the dialog) will appear in a Word 
header. You need to set the Word View to Print Layout to see this header.

You can change the document information later (for instance, if you want to add the issue number once a paper has 
been scheduled) by selecting Update Document Information from the eXtyles menu.

Having problems activating a document? 

See http://www.inera.com/support/technical-support/difficult-documents for tips.

Saving a Baseline Copy of a Document

At activation, eXtyles automatically saves a baseline copy of the file — essentially a “snapshot” of the working 
document from immediately before eXtyles activation is run. This baseline is therefore an original, pre-eXtyles 
copy of the file, saved in the same directory as the document you are editing. eXtyles also automatically saves 
baselines before Auto-Redact and Citation Renumbering are run, and you can manually create baseline copies at 
any time during eXtyles processing. These are all read-only files, to discourage users from accidentally editing them. 
Baselines are discussed in more detail in the section on Auto-Redact.

The first time a baseline copy is created — at activation — it is given the same name as the working file, plus the 
text string “$base” (for example, “Smith$base.doc”). When a second baseline is created (usually when Auto-Redact 
is run), the “$base” file is renamed with “$original,” and the new copy becomes the “$base” file. Additional baseline 
files get digits added to them (“Smith $base.doc” will become “Smith$base2.doc” when another copy is created). 
Inera may revisit these conventions and come up with a simpler system in the future, but it’s helpful to know that 
the “$base” file is always the most recent baseline copy.

Cleanup

eXtyles Cleanup is a low-level editorial pass that automatically removes unnecessary white space and Word 
formatting that is not needed for eXtyles processing and often gets in the way of editing. Some Auto Styling 
features are also run during Cleanup (see “Style Paragraphs” for more information). For the most part, when you 
open the Cleanup dialog, you can just click “OK” — the default settings have been specifically selected for your 
publication(s). There are a few options to keep in mind, however:

1 If the document has embedded images that you’d like to delete, you can select the drop-down option “Remove 
Graphics” to pull them out in one step.

2 If “Remove Section Breaks” is turned on by default and you have a landscape-oriented table in the file, 
after Cleanup the entire document will be set in landscape rather than portrait layout. We recommend that 
publications with a lot of tabular material (for instance, medical journals) have this option checked off by default 
(contact us if you’d like to make this change); you can also uncheck this option on a case-by-case basis.

Auto-Style

Cleanup also includes the Auto-Style feature that, when selected, automatically identifies regular body paragraphs, 
tables, or reference lists in the document and applies the appropriate paragraph styles.
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The Auto-Style References feature also strips errant hard returns (line breaks) that authors sometimes insert in 
the middle of a reference. If Auto-Style does the latter, it alerts the user that hard returns have been removed. For 
unnumbered (name–date) reference lists, eXtyles has to use alphabetic clues to determine where the list ends; 
therefore, if the last reference begins with a letter that is not near the end of the alphabet (say, “S”), eXtyles will let 
you know at what letter Auto-Styling left off, just in case the tool missed any subsequent references.

Style Paragraphs

Using the Palette

The buttons on the eXtyles paragraph styling palette map to a customized Word style template for your publication. 
The application of styles to your manuscripts provides consistent visual formatting, enables a smooth transition to 
your production system, and makes all of the remaining eXtyles processes possible.

When you open the style palette, eXtyles selects the paragraph where your cursor is placed. You can use the mouse 
to click on the appropriate style button or use the keyboard to apply styles with the underlined hotkeys (for 
instance, “T” to apply the “Article Title” style). eXtyles applies the style and then automatically selects the next 
paragraph in the document.

Although you can click and scroll through the document as you would normally, you can also quickly traverse 
the document, merge and delete paragraphs, and confirm or change styles using the buttons at the bottom of the 
palette:

1 With prev: Merges a paragraph into the preceding paragraph. If, for instance, you have applied the 
“Acknowledgment” style to the first paragraph of a multi-paragraph Acknowledgment, and it is your publication’s 
style to have only one Acknowledgment paragraph, you can select “With prev” to merge the subsequent 
paragraphs with the first; they will automatically take on the “Acknowledgment” style, and each hard return 
between the paragraphs will be replaced with a space.

2 New pgraf: Finds the first period, colon, question mark, or en dash and inserts a hard return after it, creating a 
new paragraph. If, for instance, the author has used run-in heads such as...

 Statistical Analysis. In the survey a total of 4118 eligible women...

... you can click on “New pgraf” to set “Statistical Analysis” in its own paragraph; the appropriate heading style 
can then be applied to it.

3 Previous: Selects the previous paragraph; does not add or remove styles.

4 Next: Selects the following paragraph; does not add or remove styles. If you hold Shift while clicking “Next” or 
typing the hotkey “x”, eXtyles will skip to the next new paragraph style.

5 Delete: Removes the selected paragraph.

6 Undo: Cancels the previous actions.

Within this dialog, you can use the Tab and Shift-Tab keys to switch between the different style tabs on the palette. 
You can also use the Esc key to close the dialog.
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Why does paragraph styling sometimes take longer than usual?

Word has a bug in which face markup (like italic or superscript) or Symbol font changes in the middle of a 

paragraph may be lost when styles are applied from the Word paragraph style drop-down menu. If eXtyles 

appears to lag during paragraph styling, look at the bottom left of the Word window for the “Repairing 

paragraph markup” message — the extra time means eXtyles is fixing this Word bug, ensuring that your 

document will not lose any critical formatting.

Table Styling

For ease of table styling and to ensure that all paragraphs in the document are properly tagged, Inera recommends 
that table titles and footnotes be placed before and after the table, respectively (outside of the table grid). eXtyles 
will normally apply the selected paragraph style to a single row of cells. To style the entire table body in one step, 
hold down the Shift key while clicking on the table body style on the palette.

Document Map 

After you style a document, you can easily navigate from heading to heading in the Navigation Pane. To open this 
window, check the box next to Navigation Pane in the View tab. A left pane will open that shows an outline view of 
the paragraphs to which a title or heading style has been applied. You can quickly traverse the document by clicking 
on the paragraphs in the left pane.

Reviewing Paragraph Styles in Word

In many situations, and especially after using the eXtyles Paragraph Styling palette, it is useful to review the styles 
you have applied to a document. Opening the Word style width area window on the left side of your document is the 
easiest way to review the styles you have applied.

To open this window, follow these steps:

1 From the Word View tab, select Draft.

2 From the File tab, select Options.

3 Select Advanced, and then navigate to the Display section.

4 Set “Style area pane width in Draft and Outline views” to a non-zero value (0.7 inches is a good starting value), 
and click OK.

Once this window is open in the Draft view, you can scroll through your document to review the styles you have 
applied to each paragraph. You can close this window by dragging the vertical line all the way to the left edge of 
your Word window.
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Auto-Redact

The eXtyles Auto-Redact dictionaries are a library of find-and-replace rules customized for your publication’s 
editorial style. eXtyles intelligently applies the rules to the document according to paragraph style — for instance, 
British-to-American spelling changes will not be made to affiliations, references, or direct quotes. eXtyles displays 
a list of dictionaries when Auto-Redact is selected, and you can open these dictionaries within the dialog to view 
individual rules. However, in most cases, you can simply click “OK” on the dialog to run Auto-Redact.

When you do so, eXtyles automatically creates a baseline copy of your manuscript. This feature allows you to select 
Compare to Baseline immediately after Auto-Redact has run, which opens a new copy of the file in which Auto-
Redact changes are displayed using Word’s Track Changes tools. Remember: do not edit the baseline comparison 
file, even if you find a change that is incorrect or spot a passage that needs to be edited — this is a transient file that 
you will most likely discard once you’ve reviewed it. Always make your changes in the working Word document.

Does eXtyles autosave the working file?

eXtyles autosaves the working file before any eXtyles process is run. Therefore, if you accidentally run an 

eXtyles process in error (for instance, if you run Auto-Redact before you’ve finished Paragraph Styling), all 

you have to do is close the document and, when prompted, click “Don’t Save.” When you reopen the file, it 

will be exactly as it was before the last eXtyles process was run.

Compare to Baseline

To compare the current version of the document being processed by eXtyles with one of the baseline copies, select 
Compare to Baseline from the eXtyles menu. If you have not used the Create New Baseline function and have only 
one baseline document saved (Document$base.doc), the working document is automatically compared with it. 
If two or more baseline versions have been saved, a dialog appears and lists all of the baseline versions that have 
been saved. The date and time appear in parentheses next to each document — for example, Document$base.doc 
(2/15/00 1:43 PM). The most recent version is highlighted at the top of the list. You can select any of the baseline 
versions to perform the comparison with your current document; in most cases (for example, after Auto-Redact or 
Citation Renumbering), you will want to select the most recent copy.

Advanced Processing

The eXtyles Advanced Processing menu includes modules that process bibliographic references and citations and 
apply character-level styling to the document. This guide discusses common Advanced Processing modules; not all 
of them may be in your eXtyles configuration, and your configuration may include modules that are not covered 
here. For additional information, see your organization’s eXtyles User Documentation.

Bibliographic References

Bibliographic Reference Processing automatically identifies reference types and restructures journal references — 
and, for those organizations that have the Book Reference Processing module, book references — according to your 
publication’s editorial style.
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What do the reference tools edit, and what don’t they edit?

Journal references are fully edited according to your editorial style — the order, punctuation, spacing, and 

formatting of reference elements will all be correct. eXtyles will not alter article titles, however, so these need 

to be carefully proofed. Book Reference Processing also fully restructures references, but the style-specific 

formatting of some elements may require additional proofing (for example, eXtyles can change “Second 

Edition” to “2nd Ed.” but currently cannot change “New Haven, CT” to “New Haven, Conn.”). For all other 

reference types, except those tagged as “unknown,” eXtyles formats the author list and highlights years and 

URLs (if present). In “unknown” references, these elements are highlighted but not formatted.

After reference processing, a typical journal reference looks like this:

<jrn>Klingensmith GJ, Garcia SC, Jones HW, Migeon CJ, Blizzard RM. Glucocorticoid treatment of girls with 
congenital adrenal hyperplasia. J Pediatr 1977;90:996–1004. </jrn>

Each component of the reference is identified and color-coded for easy proofing. The first item is the reference type 
tag, which specifies the type of reference that eXtyles has identified. Possible types are:

<jrn> Journal reference

<bok> Book reference

<edb> Edited book or book chapter reference

<conf> Conference proceeding

<eref> Reference to a web site

<lgl> Citation of a legal case or statute

<ths> Reference to a thesis/dissertation

<other> References to working papers, technical reports, patents, maps, etc.

<unknown> Unsupported or otherwise unknown reference type

In addition to fixing the order, punctuation, and face markup of references, eXtyles also corrects the abbreviation of 
journal names so that they match editorial style and standard abbreviations used for online linking. Punctuation is 
added or removed as per the publication style.

Reference Reprocessing

Once a reference has been tagged with a type, it will not be reprocessed if you reselect Bibliographic References 
from the eXtyles menu. Manually removing the reference type tags after fixing a reference will allow eXtyles to 
reprocess it. For example, the following reference was not fully edited because the last author name was incomplete 
as well as oddly formatted:

<jrn>24. Chang, C., Holtzman, D., Chau, S., Chickering, T., Woolf, E., Holmgren, L., Bodorova, J., Gearing, D., 
Holmes, W. & AH., B.: Twisted gastrulation can function as a BMP antagonist. Nature 2001;410:483-487.</jrn>
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In such cases, eXtyles inserts a warning indicating that the reference wasn’t fully processed and requires follow-up. 
PubMed Reference Checking (see below) returned a link for this reference, however, so the user can easily retrieve 
and insert the correct author name (“Brivanlou AH”) and remove the <jrn> type tags:

24. Chang, C., Holtzman, D., Chau, S., Chickering, T., Woolf, E., Holmgren, L., Bodorova, J., Gearing, D., Holmes, 
W., and Brivanlou, A.H. Twisted gastrulation can function as a BMP antagonist. Nature 2001;410:483-487.
PubMed

After selecting Bibliographic References again, the reference will be properly restructured as:

<jrn>24. Chang, C., Holtzman, D., Chau, S., Chickering, T., Woolf, E., Holmgren, L., Bodorova, J., Gearing, D., 
Holmes, W., and Brivanlou, A.H. Twisted gastrulation can function as a BMP antagonist. Nature 2001;410:483-
487.PubMed</jrn>

Bibliographic Reference Processing ignores all references with reference type tags; therefore, if the reference type 
tags have not been removed, references will not be altered when you run this process a second time.

Did eXtyles incorrectly identify a reference or its elements with no obvious author error? 

Send it to eXtyles-support@inera.com.

PubMed Reference Checking

eXtyles PubMed Reference Checking calls the PubMed batch citation checker for all journal references. In most 
eXtyles configurations, when a match is made, a “PubMed” or “PMID” hyperlink appears at the end of the reference, 
and users can click on this link to access the Medline abstract for that reference. Often missing or incorrect 
information can be easily retrieved this way. For instance, if eXtyles Bibliographic Reference Processing warns 
that a reference is missing a volume number, you can then run PubMed Reference Checking to see if the reference 
matches on Medline; if it does, you can quickly retrieve the missing information instead of doing a more time-
consuming manual search.

Sometimes a reference simply doesn’t link. To determine why, you can access the PubMed single citation matcher at 
http://www.ncbi.nlm.nih.gov/pubmed/citmatch. Sometimes warnings from Bibliographic Reference Processing will 
point you in the right direction; for instance, a warning about a page range on a reference that fails to link indicates 
that the first page number is most likely the problem; this, therefore, is the element you should leave out when 
running your search using the PubMed single citation matcher.

CrossRef Reference Checking

CrossRef Reference Checking works in much the same manner as PubMed Reference Checking. However, instead 
of a “PubMed” hyperlink at the end of a matched reference, you will see a DOI hyperlink that takes you to the 
publisher’s own web page for that particular reference.

In most eXtyles configurations, CrossRef Reference Checking is set up with fuzzy matching turned on. This means 
that the reference data does not have to be entirely accurate for CrossRef to link to it; for instance, CrossRef may 
still link to a reference with an incorrect volume number. In all cases when a link is created with fuzzy matching, 
you will receive a warning that the reference data and the CrossRef data do not match, and you will be able to click 
on the DOI to investigate the problem. Because there have been occasional problems with the accuracy of CrossRef 
data (which is deposited by individual publishers rather than compiled by an indexing organization like PubMed), 
Inera encourages users to click on the link to make sure that CrossRef’s suggestion (e.g., “CrossRef reports the 
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first author surname should be M?ller, not Müller”) matches the information provided for that reference on the 
publisher’s site.

Reference Sorting

For publications that use Harvard-style (i.e., name–date) citations, eXtyles Reference Sorting can be run after 
Bibliographic Reference Processing to sort reference lists alphabetically and according to the editorial style 
recommended by the APA, Chicago, and CSE manuals of style. Alternatively, reference sorting can be used to 
reorder reference lists according to the style used by Cell Press and the Society for General Microbiology. This latter 
style follows these rules for ordering references with the same first author surname:

1 All single-author references are listed, subsorted by year and then year letter (e.g., 2006a).

2 Next, all two-author references are listed, subsorted by second author surname, then by year, and then by year 
letter.

3 Last, all references with three or more authors are listed, subsorted by year.

If the order of two or more references is ambiguous (for instance, if there are three “Smith J, 2000” references), 
Reference Sorting inserts a warning.

Convert/Clean Numbered Citation Style

For publications that use Vancouver-style (numbered) citations, eXtyles Convert/Clean Numbered Citation Style 
automatically converts citations between different standard styles such as numbers in brackets, numbers in 
parentheses, or superscripted numbers. When you open the dialog, select the citation style used by the author, and 
eXtyles converts it to the citation style used by your publication.

Convert/Clean corrects the formatting of spacing and punctuation within numbered citations, and should be run 
even if the author used the correct citation style for the journal (e.g., to change “[1, 3-5]” to [1,3–5]”). Convert/Clean 
will also correct the punctuation surrounding the citation (e.g., converting “citation1.” to “citation.1” or vice versa) 
according to your journal requirements.

Citation Matching

Citation Matching automates checking of in-text citations with their respective objects. The goals of this feature are 
to:

1 Identify all bibliographic citations for which there is not a matching reference.

2 Identify all references for which there is not at least one citation.

3 Identify all figure, table, and box callouts for which there is not a matching legend or title.

4 Identify all figure legends, box legends, and table titles for which there is not at least one callout.

Warnings are inserted as Word comments; the citations and callouts in the manuscript are indicated with color-
coding to aid in proofing.
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How do I color-code a citation eXtyles fails to identify?  

Occasionally, eXtyles will fail to match a valid citation. For instance, superscript 2 and 3 appear so often as 

exponents that they are only treated as citations if they are immediately preceded by punctuation or are part 

of a citation range. For the remaining citation modules to work properly, all valid citations must have the 

cite_bib character style applied to them. You can use the Word format painter tool (icon shown above) or the 

Word drop-down style menu to manually apply the character style.

Check Numbered Citation Order

Check Numbered Citation Order validates the order of numbered citations and figure, table, and box callouts. When 
you open the dialog, select the citation style used in the document (usually, at this point, the correct style for your 
publication). If citations or callouts are found out of the correct order, eXtyles inserts a Word comment.

Check Numbered Citation Order may be run in documents with name–date (Harvard style) reference citations to 
check the order of figure, table, and box callouts. It does not report problems with name–date reference citations.

Check Figure/Table Callout Order

Instead of Check Numbered Citation Order, most publications that use name–date (Harvard style) citations have 
the Check Figure/Table Callout Order module, which validates the order of figure, table, and box callouts. It does 
not report problems with name–date reference citations.

Citation Renumbering

When citations are incorrectly ordered, reassigning reference numbers, reordering the reference list, and ensuring 
that each renumbered citation corresponds to the correct reference can be a difficult and frustrating chore. Citation 
Renumbering automates these processes.

It is important to note, however, that this complex automated task still requires the careful attention of the 
copyeditor, since, for instance, a missing table or even a single unidentified citation can cause a large number of 
errors when automated renumbering is run. For this reason, we encourage users to run Citation Renumbering after 
copyediting has been completed. eXtyles also autosaves a new baseline copy of the document before this process, so 
the user can run Compare to Baseline to check the accuracy of the renumbered citations and references.

Note that although Check Numbered Citation Order reports problems with figure and table callouts (for example, 
the Figure 2 callout precedes the Figure 1 callout), these elements will not be automatically renumbered or 
reordered during Citation Renumbering, which acts on reference citations only. The copyeditor must fix incorrect 
figure and table numbering by hand.

Author Processing

Author Processing automatically identifies and tags all sub-elements in the author paragraph of a manuscript. This 
tagging is used primarily for the production of XML directly from eXtyles. It can also be used to help compositors 
automatically identify author names that will be used in constructing running heads. Be sure that you have 
completed copyediting of the manuscript before you run this process, since it is designed to tag properly edited 
author lists. Use superscript markup for footnote symbols, as appropriate for your editorial style.
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Word Comments  

During Advanced Processing, some functions may automatically add queries to the document as Word comments. 
These comments highlight problems that eXtyles has identified.

In each version of Word, there are a few ways to view comments. These various options (and the differences from 
one version of Word to another) can be confusing. In Word 2007 and 2010, click Show Markup in the Review tab, 
and select the Comments check box. To view the comments as bubbles, select Print Layout from the View tab. You 
can also view comments in the Reviewing Pane by selecting a view option from the Reviewing Pane menu in the 
Review tab.

In Word 2003, you must open the Reviewing toolbar and select Final Showing Markup in the “Display for Review” 
menu to view comments. To open this toolbar, right-click on any blank area of your Word toolbar and check the 
“Reviewing” option in the dialog that appears. To view the comments as marginal balloons (often the easiest way to 
review reference warnings), you need to be in Word Print Layout. You can also use the Reviewing Pane toolbar icon 
(shown above) to view the comments listed in a new window.

Adding or deleting Word Comments will automatically renumber the remaining comments.

Export and Post-Processing Cleanup

Post-Processing Cleanup

Post-Processing Cleanup is generally run on files that need certain eXtyles-applied formatting removed, either for 
a smoother transition to desktop publishing or for sending the file back to the author for proofing. Some eXtyles 
configurations have customer-requested default settings in this dialog; in many configurations, all tasks are turned 
off by default and must be selected on a case-by-case basis. A few notable tools:

1 Convert Word Comments to Text: Publications that use embedded text rather than Word comments for author 
queries can use this tool to convert eXtyles warnings to their preferred format. These can be placed where they 
appear in the text or can be moved to the end of the file as a numbered list of queries.

2 Remove Word Text Highlights/Shading: These tools can be used to strip the color (without also removing the 
underlying character styles) for documents that will be returned to the author.

3 Remove Hyperlinks Starting with Text: Inserting either “ PubMed” or “ doi” into this field will strip the eXtyles-
inserted hyperlinks in the reference list. (Note that these text strings must be preceded by a space.)

Note that most options in Post-Processing Cleanup should not be run on files that will be exported from Word to 
XML with eXtyles.

Final Preparation for XML Export

Before selecting Export from the eXtyles menu, be sure to run the Advanced Processing function Author Processing. 
When this function is complete, and the author line has been proofed, you should be ready to export the document. 
You can export any Word document as a well-formed XML file by selecting XML w/CALS Tables (Well Formed) from 
the Export menu. Publishers with customized export filters should select those from the export menu. In either 
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case, eXtyles generates an XML file and displays it in a new document. The file is automatically saved as a text file 
with the extension .XML and the same base name as the Word document.
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